
 
 

HIBAH YAYASAN 

 

LAPORAN AKHIR 

PENGABDIAN MASYARAKAT 
 

 

 

PENYULUHAN MENGGUNAKAN MS. WORD & EXCEL UNTUK 

GURU GURU SMKN SEPATAN KABUPATEN TANGERANG 

 

 

TIM PENGUSUL 

IRMAYANTI, S.Si., M.M. 

 

 

 

 

 

 

PROGRAM STUDI D-III MANAJEMEN PERUSAHAAN 

POLITEKNIK TUNAS PEMUDA 

TANGERANG 

2023 



2 
 

HALAMAN PENGESAHAN 

PROGRAM IPTEK BAGI MASYARAKAT 

 

Judul  : PENYULUHAN MENGGUNAKAN MS. 

WORD & EXCEL UNTUK GURU GURU 

SMKN SEPATAN KABUPATEN 

TANGERANG. 

Peneliti/Pelaksana 

Nama : Irmayanti, S.Si., M.M. 

Jabatan  : Dosen 

Program studi : D-III Manajemen Perusahaan 

Anggota (1)   

Nama Lengkap : Nurjannah 

Jabatan : Mahasiswa 

Perguruan Tinggi : Politeknik Tunas Pemuda 

Anggota (2) :  

Nama Lengkap  Siska Tri Oktaviana 

Jabatan : Mahasiswa 

Perguruan Tinggi : Politeknik Tunas Pemuda 

Anggota (ke-3) :  

Nama Lengkap : Safirul Huda 

Jabatan : Mahasiswa 

Perguruan Tinggi : Politeknik Tunas Pemuda 

Tahun Pelaksana : Tahun ke-1dari rencana 1 tahun 

Biaya tahun berjalan : Rp 2.000.000 

Biaya keseluruhan : Rp 2.000.000 
 

 
Mengetahui, Tangerang,  Oktober 2023 

Kaprodi Ketua TimPengusul, 

 

 

 

 

 

Novi Nurwanto, S.E., M.M.                        Irmayanti, S.Si., M.M. 

 

Mengetahui 

Kepala LPPM,  

 

 

 

 

 

Iswadi, S.Pd., M.Pd. 



3 
 

BAB I 

PENDAHULUAN 

 

 

 

Kemajuan ilmu pengetahuan dan teknologi suatu bangsa tentu tidak terlepas dari 

keberhasilan proses pembelajaran di lembaga-lembaga serta institusi-institusi pendidikan 

tinggi di negara tersebut. Tahapan perubahan diharapkan mampu membawa bangsa ke arah 

kemajuan peradaban yang lebih tinggi dan meresap secara utuh sebagai jati diri bangsa 

tersebut. Tingkat penguasaan ilmu dan teknologi merupakan bukti nyata keberhasilan 

pembangunan. Peningkatan penguasaan ilmu dan teknologi tidak hanya dilakukan pada 

pendidikan formal, namun juga dapat dilakukan melalui pendidikan nonformal. Menurut 

Undang-Undang No.20 Tahun 2003 Tentang Sistem Pendidikan Nasional dijelaskan pada 

Pasal 26 ayat 3: Pendidikan nonformal meliputi pendidikan kecakapan hidup, pendidikan 

anak usia dini, pendidikan kepemudaan, pendidikan pemberdayaan perempuan, pendidikan 

keaksaraan, pendidikan keterampilan dan pelatihan kerja, pendidikan kesetaraan, serta 

pendidikan lain yang ditujukan untuk mengembangkan kemampuan peserta didik. Hal 

mengenai pendidikan dan pelatihan kerja diperjelas pada ayat 5 “Kursus dan pelatihan 

diselenggarakan bagi masyarakat yang memerlukan bekal pengetahuan, keterampilan, 

kecakapan hidup, dan sikap untuk mengembangkan profesi, bekerja, usaha mandiri, atau 

melanjutkan pendidikan kejenjang yang lebih tinggi”. Salah satu jenis pelatihan yang 

dimaksud adalah pelatihan keterampilan komputer. Pelatihan keterampilan komputer 

adalah serangkaian kegiatan yang memberikan kesempatan untuk mendapatkan dan 

meningkatkan keterampilan yang berkaitan dengan komputer.. Undang-Undang Nomor 20 

Tahun 2003 tentang Sistem Pendidikan Nasional memberikan dasar hukum untuk 

membangun pendidikan nasional dengan menerapkan prinsip demokrasi, desentralisasi, 

otonomi, keadilan dan menjunjung tinggi hak azasi manusia. Penerapan ketentuan dalam 

undang-undang ini diharapkan dapat mendukung segala upaya untuk memecahkan masalah 

pendidikan, guna memberikan sumbangan yang signifikan terhadap masalah-masalah 

makro bangsa Indonesia. Semua lapisan masyarakat terkait langsung maupun tidak 

langsung, baik sebagai konseptor maupun pengambil keputusan serta pelaksana dunia 

pendidikan diharapkan memiliki pemahaman tentang undang-undang tersebut sehingga 

mampu memberikan makna dalam pengembangan pendidikan dalam rangka terciptanya 

sumber daya manusia Indonesia yang berkualitas. Teknologi informasi memiliki 

perkembangan yang sangat pesat dan meliputi berbagai bidang. Bidang pendidikan 
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merupakan salah satu bidang yang dipengaruhi oleh teknologi informasi. Baik dalam 

proses pembelajaran formal di sekolah maupun nonformal berupa pelatihan di luar sekolah. 

Teknologi informasi menjadi salah satu pendukung dalam suksesnya penerapan kurikulum 

2013. Setiap guru harus mampu menguasai teknologi informasi dalam proses belajar 

mengajar maupun dalam persiapan materi pelajaran. 
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BAB II 

LANDASAN TEORI 

 

 

 
1. Sejarah Microsoft Word 

Banyak ide dan konsep Word diambil dari Bravos, pengolah kata 

berbasis grafik pertama yang dikembangkan di Xerox Palo Alto Research Center 

(PARC). Pencipta Bravo,Charles Simonyi, meninggalkan Xerox PARC dan 

pindah ke Microsoft pada 1981. Simonyi juga menggaet Richard Brodie dari 

PARC. Pada 1 Februari 1983, pengembangan Multi-Tool Word dimulai. 

Setelah diberi nama baru Microsoft Word, Microsoft menerbitkan 

program ini pada 25 Oktober 1983 untuk IBM PC. Saat itu dunia pengolah kata 

dikuasai oleh WordPerfectdan juga WordStar. 

Word memiliki konsep "What You See Is What You Get", 

atau WYSIWYG, dan merupakan program pertama yang dapat menampilkan cetak 

tebal dan cetak miring pada IBM PC. Word juga banyak 

menggunakan tetikus yang saat itu tidak lazim sehingga mereka menawarkan 

paket Word-with-Mouse. Word processor berbasis DOS lain, 

seperti WordStar dan WordPerfect, menampilkan hanya teks dengan 

kodemarkup dan warna untuk menandai pemformatan cetak tebal, miring, dan 

sebagainya. 

Word untuk Macintosh, meski memiliki banyak perbedaan tampilan dari 

versi DOS-nya, diprogram oleh Ken Shapiro dengan sedikit perbedaan dari kode 

sumber versi DOS, yang ditulis untuk layar tampilan resolusi tinggi dan printer 

laser, meskipun belum ada produk seperti itu yang beredar untuk publik. 

Setelah LisaWrite dan MacWrite, Microsoft pun mencoba untuk menambahkan 

fitur WYSIWYG ke dalam paket program Word for Macintosh. Setelah Word for 

Macintosh dirilis pada tahun 1985, program tersebut mendapatkan perhatian yang 

cukup luas dari masyarakat pengguna komputer. Microsoft tidak membuat versi 

Word 2.0 for Macintosh, untuk menyamakan versi dengan Word untuk sistem atau 

platform lainnya. 
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Versi selanjutnya dari Word for Macintosh, adalah Word 3.0, yang dirilis 

pada tahun 1987. Versi ini mencakup banyak peningkatan dan fitur baru tapi 

memiliki banyak bug. Dalam hanya beberapa bulan, Microsoft mengganti Word 

3.0 dengan Word 3.01, yang jauh lebih stabil. Semua pengguna terdaftar dari Word 

3.0 dikirimi surat yang berisi salinan Word 3.01 secara gratis, sehingga 

menjadikan hal ini kesalahan Microsoft paling mahal untuk ditebus pada waktu itu. 

Word 4.0, yang dirilis pada tahun 1989, merupakan versi yang sangat sukses dan 

juga stabil digunakan. 

Tahun 1990-1995 

Pada rentang tahun ini, Word for Windows diluncurkan. Versi pertama 

dari Word for Windows dirilis pada tahun 1989 dengan harga 500 Dolar Amerika 

Serikat. Dengan dirilisnya Microsoft Windows 3.0 pada tahun selanjutnya, 

penjualan pun akhirnya terdongkrak naik, mengingat Word for Windows 1.0 

didesain untuk Windows 3.0 dan performanya sangat buruk jika dijalankan pada 

versi sebelumnya. Microsoft menunggu hingga merilis Word 2.0 untuk 

mengukuhkan Microsoft Word sebagai pemimpin pasar pengolah kata. 

Selain, Microsoft Word, ada beberapa jenis word processor yang popular 

dan sudah beredar di masyarakat diantaranya : WordStar (WS), WordPerfect (WP), 

AmiPro, WordPad, dan lain-lain. Microsoft Word sebagai program pengolah kata 

memberikan fasilitas-fasilitas yang lebih familiar dibandingkan dengan pengolah 

kata lainnya. 

Program pengolah kata Microsoft Word telah mengeluarkan versi 1.0. 

sampai 6.0. untuk versi DOS. Kemudian, seiring dengan kemajuan perusahaan 

pembuatnyya, Microsoft Coorporation telah mengeluarkan 12 versi Microsoft 

Word, yaitu versi ’95, ’97, 2000, 2002, 2003, 2007, 2010, dan 2013. 

 

2. Pengenalan Microsoft Word 2003 

Microsoft Word merupakan program untuk mengolah kata (teks). Program 

ini bisa digunakan untuk menulis dokumen misalnya skripsi, novel, laporan 

penelitian, laporan,dan sebagainya. Selain menulis teks, MS Word juga dapat 

digunakan untuk bekerja dengan tabel, teks artistik, formula, menyisipkan gambar, 
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shape, bagan organisasi dan lainnya. Di bawah ini adalah menu-menu dan 

fungsinya yang ada di Microsoft Word 2003. 

 

Gambar.TampilanMs Office Word 2003 

 

1. Title Bar : berisi judul dokumen dan tombol, minimize,maximize,Exit 

2. Menu Bar : berisi menu-menu shorcut perintah dalam word 

3. Toolbar : berisi tombol-tombol shorcut perintah dalam word 

4. Tombol close dokumen 

5. Task Pane : Panel task (kumpulan task dalam word) 

6. Vertical scroolbar : menggeser tampilan dokumen secara vertical 

7. Horizontal scroolbar : menggeser tampilan dokumen secara horizontal 

8. Halaman tempat membuat teks atau dokumen 

9. Horisontal Ruler : melihat atau mengatur batas teks 

10. Ruler indent : mengatur tabulasi 

11. Kursor : penanda posisi aktif pengetikan secara default teks yang diketik akan 

ditempatkan di kursor 

12. Vertikal ruler :melihat atau mengatur batas teks 

13. Toolbar drawing : kumpulan tombol shorcut untuk membuat gambar atau 

bentuk sederhana 
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14. Status bar : untuk menampilkan halaman yang aktif, jumlah halaman, baris dan 

kolom yang aktif 

3. Cara Memulai Menggunakan Microsoft Word 2003 

Untuk memulai Word, Lakukan langkah-langkah berikut: 

1. Bisa dengan menggunakan klik shorcut Word yang ada di desktop, atau Pada 

start menu pilih Programs => Microsoft Office => Microsoft Office Word 

2003 

 

Gambar. Memulai Ms. Office Word 2003 

 

2. Setelah muncul lembar kerja word 

File => New (untuk membuat dokumen baru) 

File => Page Setup (untuk mengatur setting halaman) 
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Gambar. Sub menu menuju Page Setup 

 

3. Pada kotak dialog Page Setup, pilih tab Margin , atur margin sesuai keinginan: 

Jika satuannya bukan cm ada dapat mengubahnya  

• Pada Menu bar pilih Tools => Options 

• Pada kotak dialog Options pilih tab General pada item Measurement 

unit pilih centimeter 

• Klik OK 
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Gambar. Kotak instruksi Pengaturan tepi kertas 

 

4. Untuk mengatur ukuran halaman agar sesuai ukuran kertas , pilih tab Pages => 

Pages Size, pilih A4 atau Legal sesuai kertas anda. 

 

Gambar. Kotak Instruksi Page Setup 
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5. Mengatur Header dan Footer (berguna untuk mengatur jarak antara nomor 

halaman atau catatan kaki dengan tulisan) 

 

Gambar.KotakInstruksi Page Setup 

 

4. Cara Mengatur Nomor Halaman 

1. Klik pada section pertama. 

2. Pada menu View , Klik Header and Footer. 

3. Klik pada footer dimana anda akan membuat nomor halaman. 

4. Pada toolbar Header and Footer, Klik ikon Insert Page Number. 

5. Pada toolbar Header and Footer, Klik ikon Format Page Number. 

6. Dalam kotak Number format, Klik format yang anda ingin beri nomor 

halaman padasection ini. Klik OK. 

7. Pada toolbar Header and Footer, Klik ikon Page Setup. 

8. Dalam kotak Headers and Footers, Klik kotak “Different first page” untuk 

mematikan nomor halaman pada halaman awal. 

9. Klik pada footer dari section kedua. 

10. Pada toolbar Header and Footer, Klik ikon Link to Previous untuk memutus 

koneksi antara footers dari dua sections. 

11. Hapus nomor halaman pada footer section kedua. 



12 
 

12. Klik dalam header dari section kedua. 

13. Pada toolbar Header and Footer, Klik ikon Link to Previous untuk memutus 

koneksi antara headers dari dua sections. 

14. Pada toolbar Header and Footer, Klik ikon Insert Page Number. 

15. Pada toolbar Header and Footer, Klik ikon Format Page Number. 

16. Dalam kotak Number format, Klik format yang anda inginkan untuk nomor 

dalamsection ini. 

17. Tutup toolbar Header and Footer. 

 

5. Mengatur Paragraf 

Selain menggunakan tombol shortcut, anda juga bisa menggunakan cara 

berikut ini untuk mengatur paragraf di word 2003. Cara mengatur paragraf berikut 

ini dengan melakukan teknik blok secara manual pada teks kemudia menggunakan 

option paragraph untuk mengatur ukuran paragraf /tinggi baris. 

 

1. Pada Menu bar, pilih Format => Paragraph  

 

Gambar.Pemilihan Sub Menu Paragraph 

 

2. Pada kotak dialog Paragraph, atur spacing before dan after (biasa digunakan 

untuk mengatur spasi antara Judul atau sub judul dengan isi tulisan) 

Pada Line spacing pilih spasi yang diinginkan. Klik OK 
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Gambar.KotakinstruksiPengaturan Spacing Before and After 

 

3. Hasilnya akan tampak seperti di bawah ini 

 

Gambar.HasilPengaturanspacing before dan after 

 

 

A. Microsoft Office Power Point 

1. Penjelasan Microsoft Powerpoint 

Microsoft powerpoint adalah salah satu perangkat lunak yang sering digunakan 

untuk membuat file presentasi yang dikembangkan Microsoft. Dalam microsoft 

powerpoint kita dapat membuat file presentasi dalam sllide-slide yang dapat kita 

sisipkan file video, music, animasi, dan efek-efek lainnya supaya presentasi 
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menjadi menarik dan tidak membosankan. Microsoft Powerpoint yang akan kita 

bahas adalah versi 2007, tampilan powerpoint 2007 sangat mudah dan tersedia 

menu tabulasi atau tab menu seperti Home, Insert, Design, Animations, slide 

Show, Review, View, dan Add-Ins. 

  Tampilan Microsoft Powerpoint 

 

 

 

2. Membuka Microsoft Office Powerpoint 2007 

Untuk membuka powerpoint, kita dapat lakukan dengan beberapa cara seperti berikut 

: 

1. -     Klik tombol Start 

- Lalu Klik All Program 

- Cari Microsoft Office lalu klik 

- Klik Microsoft Office Powerpoint 2007, maka akan muncul tampilan 

Microsoft Office Powerpoint seperti gambar diatas. 

2. -     klik tombol start 

- Lalu klik Run 

- Ketikan “powerpoint” 

- Enter/klik tombol OK 
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Setelah terbuka barulah kita dapat membuat presentasi pada slide-slide yang sudah 

disediakan. 

 

3. Membuat File Presentasi 

a.  Membuat Presentasi Menggunakan Microsoft Office Powerpoint 

Untuk membuat file presentasi baru pada Ms. Powerpoint kita dapat melakukan 

langkah sebagai berikut : 

- Klik Office Button > klik New 

- Pada kotak dialog Pilih dan klik Blank & Recent > Blank Presentation > 

pilih/klik tombol Create. 

Untuk menambahkan slide dan memilih layout pada Ms. Powerpoint dapat dilakukan 

dengan cara sebagai berikut : 

- Dalam menu tab Home pilih dan klik New Slide untuk menambahkan slide 

baru, apabila kita memilih tombol New Slide bagian atas, maka kita akan 

disajikan slide dan layout default yaitu slide Title and Content. 

- Sedangkan untuk memilih jenis slide dan layout yang berbeda, maka pilih dan 

klik tombol New Slide bagian bawah maka akan muncul beberapa tampilan 

slide dan layout 

- Untuk mengubah layout yang sudah ada kita dapat memilih tombol Layout 

pada samping tombol New Slide. 
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   Contoh Tampilan Layout Ms. Powerpoint 

 

b. Menentukan Tema atau Background 

Untuk membuat file presentasi agar tampil lebih menarik kita dapat menentukan 

Background sesuai dengan yang kita inginkan dengan cara sebagai berikut : 

- Pilih dan klik tab Design lalu pilih tema atau background yang di inginkan 

pada kolom Themes. 

- Selain tema yang tersedia kita dapat menyisipkan file foto sebagai tema atau 

background dengan cara klik Background Styles lalu klik Format Background 

tandai Picture or texture fill. Pada Insert from klik File lalu pilih gambar atau 

foto yang kita inginkan setelah dipilih klik insert maka tampilan background 

pada slide kita akan berubah. 

 

c. Menambahkan dan Memformat Teks 

Untuk menambahkan dan memformat teks, kita dapat melakukannya dengan cara 

sebagai berikut : 

- Setelah slide terbuka, klik kotak yang tersedia dengan tulisan “ Click to add 

title” untuk menulis judul presentasi dan ganti dengan tulisan yang akan kita 

buat. 

- Untuk memformat teks kita dapat lakukan dengan cara blok teks terlebih 

dahulu, lalu format teksnya bisa kita ganti hurufnya, ukuran hurufnya, 

ketebalan dan yang lain-lainnya. 

- Selanjutnya pada kotak subtitlenya pun caranya sama dengan dia atas. 

Biasanya dalam menulis file presentasi kita juga harus memformat paragraf, bullets, 

numbering, dan spasi. Untuk memformatnya sama seperti kita memformat file di Ms. 

Word. 

 

d. Menyisipkan Clip Art dan Picture 

Untuk menyisipkan Picture dan Clip Art kita dapat menggunakan langkah-langkah 

sebagai berikut : 

- Klik menu Insert > pilih Picture atau Clip Art 
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- Lalu pilih gambar yang kita inginkan, setelah itu atur dan format gambarnya 

sesuai keinginan kita agar presentasi yang ditampilkan akan semakin menarik. 

 

e. Menambahkan Transisi Slide 

Dengan menambhakan transisi slide, kita dapat menyajikan presentasi lebih menarik. 

Langkah-langkahnya adalah sebagai berikut : 

- Pilih slide yang akan kita ubah 

- Lalu klik menu Animations dan pilih Transition scheme 

- Dalam transition scheme terdapat beberapa transisi yang telah disediakan 

Microsoft Powerpoint dan terbagi dalam tiga kategori yaitu No transition, 

Fades and Dissolves, Wipes, Push and Cover, Stripes and Bar, dan Random. 

- Setelah memilih transisi yang diinginkan kita dapat memilih kecepatan transisi 

sesuai dengan keinginan kita, selain itu kita juga dapat menambahkan efek 

suara-suara yang sudah di sediakan pada Ms. Powerpoint.  

- Untuk membuat semua slide memiliki efek yang sama kita dapat memilih dan 

klik Apply to all. 

- Sedangkan pada opsi Advance slide, terdapat On Mouse Click gunanya ialah 

slide akan berpindah ke slide selanjutnya apabila mause kita klik. Sedangkan 

Automatically After digunakan untuk berpindah sesuai dengan waktu yang 

kita inginkan. 

- Untuk melihat efek yang kita buat kita dapat melihatnya dengan cara kita klik 

Slide Show 

 

f. Menambahkan Animmasi 

Kita dapat menambahkan animasi pada teks, gambar dan yang lainnya pada file 

presentasinya. Untuk menambahkan animasi ialah sebagai berikut : 

- Pilih objek yang akan diberi animasi 

- Pilih menu Animations, dan pilih Custom Animations 

- Kemudian klik Add Effect 

- Pilih Entrance, untuk melihat semua tampilan efek yang disediakan pilih More 

Effect, lalu pilih efek yang di inginkan pada kotak Add Entrance Effect lalu 

klik OK. 

- Untuk menampilkan efek yang telah kita pilih dapat kiita lihat dengan cara klik 

Slide Show. 
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g. Menambahkan File Sound (Musik) dan Video pada Slide 

Untuk menambahkan file Musik dan Video dapat dilakukan dengan cara sebagai 

berikut : 

- Pilih menu Insert 

- Pilih dan klik Media Clips, klik Sound jika kita akan menambahkan file musik, 

dan Movie jika akan menambahkan file Video. 

- Cari file yang akan kita sisipkan lalu klik OK 

- Selanjutnya powerpoint akan menampilkan pilihan untuk menjalankan file 

secara otomatis maka pilih Automatically dan When Click bila kita ingin 

menjalankan file ketika mouse kita klik. 

- Kemudian masuk pada menu Option yang berada dibawah Sound Tolls. Pada 

menu ini kita dapat mengatur volume file pada Slide Show Volume, 

menyembunyikan file dengan Hide During Show, jika kita ingin menampilkan 

file berulang-ulang kita dapat memilih Loop Until Stopped, untuk memutar 

file kita dapat memilih Preview 

 

h. Menyimpan Dokumen Powerpoint 

Untuk menyimpan powerpoint yang telah kita buat, dapat dilakukan dengan langkah 

sebagai berikut : 

- Klik Office Button > save > pilih folder yang akan kita simpan file 

powerpointnya > tulis nama file presentasi yang kita buat > klik Save 

- Selain cara diatas kita dapat menggunakan cara dengan menggunakan tombol 

keyboard yaitu Ctrl+S 

 

 

B. Pengenalan dan Sejarah Microsoft Excel 

1. Pengenalan Microsoft Excel 

Microsoft Excel atau Microsoft Office Excel adalahsebuah program 

aplikasilembarkerja spreadsheet yangdibuatdandidistribusikanoleh Microsoft 

Corporation untuk system operasi Microsoft Windows dan Mac 

OS.Aplikasiinimemilikifiturkalkulasidanpembuatangrafik yang baik, 

denganmenggunakanstrategi marketing Microsoft yang agresif, menjadikan 

Microsoft Excel sebagaisalahsatu program komputer yang populerdigunakan di 
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dalam computer mikrohinggasaatini. Bahkan, saatini program inimerupakan 

program spreadsheet paling banyakdigunakanolehbanyakpihak, baik di platform 

PC berbasis Windows maupun platform Macintosh berbasis Mac OS, 

semenjakversi 5.0 diterbitkanpadatahun 1993. Aplikasiinimerupakanbagiandari 

Microsoft Office System, danversiterakhiradalahversi Microsoft Office Excel 

2013 yang diintegrasikan di dalampaket Microsoft Office System 2013 . 

Microsoft Excel merupakanperangkatlunakuntukmengolah data 

secaraotomatismeliputiperhitungandasar,  penggunaanfungsi-fungsi, 

pembuatangrafikdanmanajemen data. 

Perangkatlunak  ini  sangatmembantuuntuk  menyelesaikanpermasalahan  admini

strative mulai  yang  paling  sedernaha  sampai  yang  lebihkompleks. 

Permasalahansederhanatersebutmisalnyamembuatrencanakebutuhanbarangmelip

utinamabarang, jumlahbarangdanperkiraanhargabarang. 

Permasalahaninisebenarnyadapatjugadiselesaikanmenggunakan Microsoft Word 

karenahanyasedikitmemerlukan proses perhitungan, 

tetapilebihmudahdiselesaikandengan Microsoft Excel. Contoh  permasalahan yang 

lebihkompleksadalahpembuatanlaporankeuangan (general ledger) yang 

memerlukanbanyakperhitungan, manajemen  data dengan  menampilkangrafik 

data pivot table ataupenggunaanfungsi – 

fungsimatematisataupunlogikapadasebuahlaporan. Penyelesaianpermasalahan 

yang komplekjugadapatmemanfaatkanpemograman macro yang disediakanoleh 

Excel agar proses penggunaanlebihmudah. 

 

2. Penggunaan Microsoft Excel 

a. Menu dan icon pada Microsoft Excel 
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Gambar 1. Unsur-unsurutamaLayar Microsoft Excel 2007 

 

1. Judul 

Menampilkan judul program dan dokumen aktif atau nama file dari lembar kerja 

yang aktif. 

2. Office Button 

Berisi barisan perintah untuk pengoperasian Program yang standar misalnya 

membuat dokumen baru, membuka dokumen lama, menyimpan, mencetak dan 

mempublish dokumen. 

3. Akses Cepat Toolbar (Quick Access Toolbar) 

4. Merupakan sarana yang disediakan Microsoft Excel untuk mempercepat akses 

berkomunikasi dengannya misalnya menyimpan, mencetak dan sebagainya. 

5. Toolbar 

6. Merupakan deretan tool-tool (gambar-gambar) yang mewakili perintah dan 

berfungsi untuk mempermudah dan mengefisienkan pengoperasian program. 

7. Help 

Bila kita ingin bertanya sesuatu, maka ketik pertanyaan anda pada tempat tersebut. 

Ms.Excel akan memberikan alternatif jawaban terhadap pertanyaan yang 

dimaksud. 

8. Lembar Kerja (Workbook) 

Baris ini berisikan informasi halaman, section, letak insertion point dan tombol 

pengendali. 
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9. Cell 

Cell Aktif Penggulung vertikal 

10. Lembar aktif 

11. Nama Range 

12. Fungsi 

13. Penggulung 

14. Nomor Baris 

15. Nomor Kolom 

 

 

3. Membuat dokumen pengolah angka 

Dari contoh pengelolaan data sederhana kita akan belajar tentang cara 

pengetikan di excel, alignment, cara memformat huruf, cara memformat tabel dan 

cell. Berikut adalah contoh penerapan Microsoft Excel dalam bidang keguruan : 

 

Gambar 2. PengisianDaftarNilaiSiswa 

 

4. Penerapan Microsoft Excel 

Microsoft Excel dapatLangkah-langkah membuat dokumen daftar unit 

kerja seperti pada Gambar 2 adalah sebagai berikut: 

1) Buat Judul dan Sub Judul Laporan 
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Arahkan kursor pada Cell A1 (Kolom A dan Baris 1), kemudian ketikkan tulisan 

“DAFTAR NILAI SISWA” pada Cell aktif tersebut. Kemudian ketikkan sub judul 

laporan pada Cell A1, A2, A3, dan M5 seperti pada tampilan diatas. 

2) Penggunaan alignment, format font dan format Cell 

3) Untuk membuat Judul Laporan letaknya di tengah-tengah tabel maka arahkan 

kursor ke A1 kemudian select cell mulai A1 sampai F1. Kemudian klik tombol 

Merge Cell agar judul laporan terletak ditengah-tengah tabel. 

 

Gambar 3MeletakkanJudulDitengah 

 

Agar huruf pada judul laporan dan tabel tebal maka arahkan kursor pada cell 

kemudian klik tombol Bold atau dapat juga melakukan format font lainnya seperti 

underline atau italic. 

Selanjutnya data dapat dilengkapi seperti Gambar 2. 

4) Penggunaan format Tabel dan Cell 

Microsoft Excel menyediakan fasilitas format table dengan beberapa 

template seperti memberi border, warna border, warna cell dan style font dengan 

kliktombol format table seperti ini , kemudia akan muncul pilihan style formattabel 

seperti berikut ini. 

Kita juga dapat melakukan format tabel dan format cell sesuai selera kita 

atau tidak menggunakan template yang disediakan Microsoft Excel. Seperti 

contohnya pada Gambar 2. menggunakan format tabel dan cell sendiri dengan cara 

: 
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Gambar 4Pengaturan Style Tabel 

 

Untuk membuat border pada tabel, blok tabel yang akan di beri border 

dalam hal ini mulai cell A7 sampai M21, kemudian klik panah pada tombol dan 

pilih All Border seperti pada tampilan dibawah ini. 

 

Gambar 5PembuatanTabel 

 

 Untuk memberi warna pada judul tabel bisa menggunakan fasilitas format 

cell dengan cara blok cell A7 sampai M8 kemudian klik tombol kemudian akan 

muncul pilihan style cell yang akan kita pilih seperti pada tampilan dibawah ini. 
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Gambar 6fasilitas format cell 

 

5. Macam-macam formula 

a. =SUM(…) 

Fungsinya :Untukmelakukanpenjumlahan 

Bentukumum : =SUM(range sel) 

Contoh : Misalkan kita akan menjumlahkan dari sel H5 sampai sel H15 

Penulisan : =SUM(H5:H15) 

b. =COUNT(…) 

Fungsinya : Untuk melakukan counter 

Bentuk umum : =COUNT(range sel) 

Contoh : Misalkan kita akan menghitung jumlah pegawai yang berada di sel 

B5 sampai sel B15 

Penulisan : =COUNT(B5:B15) 

c. =MAX(…) 

Fungsinya : Untuk mencari nilai maksimum (terbesar) 

Bentuk umum : =MAX(range sel) 

Contoh : Misalkan kita ingin menetukan nilai terbesar dari sederetansel yang 

berada di sel F1 sampai sel F17 

Penulisan : =MAX(F1:F17) 

e. =MIN(…) 

Fungsinya : Untuk mencari nilai minimum (terkecil) 
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Bentuk umum : =MIN(range sel) 

Contoh : Misalkan kita ingin menentukan nilai terkecil dari sederetan sel yang 

berada di sel F1 sampai sel F17 

Penulisan : =MIN(F1:F17) 

f. =AVERAGE(…) 

Fungsinya : Untuk mencari nilai rata-rata 

Bentuk umum : =AVERAGE (range sel) 

Contoh : Misalkan kita ingin mengetahui nilai rata-rata dari sel A11 sampai 

A17 

Penulisan :=AVERAGE(A11:A17) 

g. =ABS(…) 

Fungsinya : Untuk mengubah angka-angka yang ada dalam daftar 

argumennya menjadi bilangan mutlak (absolut) 

Bentuk umum : =ABS(range sel) 

Contoh : Misalkan kita bermaksud mengetahui secara mutlak dari sel yang 

kita aktifkan, misal di sel F17 

Penulisan : =ABS(F17) 

h. =SQRT(…) 

Fungsinya : Untuk menghitung akar dari bilangan X. Bilangan X tidak boleh 

negatif 

Bentuk umum : =SQRT(range sel) 

Penulisan : = SQRT(25) 

i. =IF(…;…;…) 

Fungsinya : Untuk mengecek apakah nilai yang kita gunakan sebagai kunci 

benar atau salah (memenuhi syarat atau tidak) 

Bentuk umum : =IF(logical_test ; Value_if_true ; Value_if_false) 

Contoh : Misalkan kita akan membandingkan nilai di suatu sel yang 

berada di sel F17, tentang kriteria siswa dinyatakan lulus atau gagal dengan 

ketentuan sbb.Jika nilai rata-rata siswa lebih besar samadengan 60, maka 

siswa dinyatakan LULUS, dan sebaliknya. 

Penulisan : =IF(F17>=60:”LULUS”;”GAGAL”) 

artinya jika kolom F17 lebih besar sama dengan 60, maka LULUS, jika 

kurang dari 60, maka GAGAL 

Keterangan : 
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Jika kondisi di sel F17 terpenuhi, maak kerjakan Value_if_true, jika kondisi 

di sel F17 tidak terpenuhi, maka kerjakan Value_if_false 

j. =DATE(Year,Month,Date) 

Fungsinya : Untuk menghitung jumlah hari 

Contoh : =DATE(73,8,11) à 26887 hari 

k. =VLOOKUP 

Fungsinya : Untuk pembacaan suatu tabel secara vertikal 

Bentuk umum : =VLOOKUP(lookup_value; table_array; Col_index_num; 

Range_lookup) 

l. =HLOOKUP 

Fungsinya : Untuk pembacaan suatu tabel secara horizontal 

Bentuk umum :=HLOOKUP(lookup_value; table_array; Col_index_num; 

Range_lookup) 

m. =LEFT(…;…) 

Fungsinya : Untuk mengambil teks sejumlah karakter tertentu dari sebuah 

kiri 

Bentuk umum :=LEFT(teks;jumlah karakter yang diambil) 

Contoh : Misal kita akan mengambil karakter yang ada di sel F17 (Februari) 

sebanyak 3 huruf 

Penulisan : =LEFT(F17;3) à hasilnya Feb 

n. =RIGHT(…;…) 

Fungsinya :Untuk mengambil teks sejumlah karakter tertentu dari sebuah 

kanan 

Bentuk umum :=RIGHT(teks;jumlah karakter yang diambil) 

Contoh :Misal kita akan mengambil karakter yang ada di sel F17 (Februari) 

sebanyak 3 huruf 

Penulisan :=RIGHT(F17;3) à hasilnya ari 

o. =MID(…;…;…) 

Fungsinya : Untuk mengambil teks dari kedudukan tertentu dengan sejumlah 

karakter tertentu 

Bentuk umum :=MID(teks;start_number; number_char) 

Contoh : Misal kita akan mengambil karakter baru yang ada di sel F17 

(Februari) 

Penulisan : =MID(F17:3:3) 
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BAB III 

METODE PELAKSANAAN 

 

 

 

Dalam pelatihan ini, ibu-ibu akan diajarkan dan didampingi untuk memahmi dan 

mempraktekan. Adapun susunan acara kegiatan penyuluhan ini adalah 

 

NO HARI/TGL PUKUL KEGIATAN 

1 10 Oktober 2023 07.00 – 08.00 Registrasi peserta (siswa) 

2 
10 Oktober 2023 

08.00 – 09.00 
Sambutan – sambutan 

(kepala sekolah dan guru) 

3 
10 Oktober 2023 

09.00 – 10.00 
Penyampaian materi dan 

tanya jawab 

4 10 Oktober 2023 10.00 – 11.00 Praktik 

5 10 Oktober 2023 11.00 – 12.00 Ramah tamah dan penutup 
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BAB IV.  

KELAYAKAN PERGURUAN TINGGI 

 

Kinerja Lembaga Penenlitian dan Pengabdian kepada Masyarakat (LPPM) 

Akademi Sekretari dan Manajemen Dharma  Budhi BhaktiJakarta Utara sebagai 

lembaga yang menaungi seluruh kegiatan dosen dan mahasiswa  dalam pelaksanaan 

pengabdian kepada masyarakat diantaranya adalah  

a) LPPM menginformasikan setiap informnasi pengajuan proposal, baik dari 

sumber  dana Institusi maupun sumber dana Dikti dan cara pengusulannya sesuai 

dengan panduan DP2M Dikti.  

b) LPPM menyeleksi usulan proposal yang masuk ke LPPM dan yang memenuhi 

syarat diusulkan ke DP2M Dikti maupun ke institusi 

c) LPPM mengkoordinasi pelaksanaan pengabdian kepada masyarakat secara 

melembaga, baik secara administratif maupun keuangan.  

d) LPPM memonitor dan mengevaluasi pelaksanaan pengabdian kepada 

masyarakat di lapangan.  

e) LPPM memfasilitasi setiap kegiatan pengabdian kepada masyarakat sesuai 

dengan  fasilitas  yang tersedia. Sumberdaya manusia yang terlibat dalam 

kegiatan ini adalah dosen yang  memiliki kepakaran untuk menyelesaikan 

persoalan mitra dan mahasiswa yang membantu aspek teknis 

 

No Nama Status Tugas dan Kewajiban 

1. SARMILIS Ketua Mengorganisir kegiatan  

pelaksanaan pengabdian  

masyarakat, dari  

mengakomodasikan informasi,  

permasalahan, solusi alternatif, 

Desain dan prosedur  

pengabdian masyarakat,  

pemantauan laporan kegiatan  

serta komunikasi dengan pihak  

lain. 

2 Hadi Buhro, Saidi 

Hanafi 

Gugun Purnomo 

Anggota 1 Membantu ketua, absensi, Mc, 

moderator, dokumentasi 



29 
 

BAB V BIAYA DAN JADWAL PENELITIAN 

 

5.1 ANGGARAN BIAYA 

No Jenis Pengeluaran Biaya Yang Diusulkan (Rp) 

1. Perjalanan Rp. 1.500.000,- 

2. Konsumsi Rp. 2.000.000,- 

3. Bahan habis pakai dan peralatan Rp 1.000.000,- 

4. Lain-lain(publikasi,seminar,laporan)  Rp. 500.000,- 

 Total Rp. 5.000.000,- 

5.2.JADWAL  

NO Jenis  kegiatan Bulan 

  5 6 7 8 9 10 

1. Persiapan dan 

survey 

      

2. Menyusun dan 

mengajukan 

proposal  

      

3. Menyiapakan alat 

dan bahan 

      

4. Pelaksanaan 

kegiatan 

      

5. Pelaporan       
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BAB VI 

 KESIMPULAN  

 

 

 

Dalam pelaksanaannya kegiatan ini sangat bermanfaat dalam pengembangan dan 

pembelajaran kepada warga khususnya dalam acara PENYULUHAN 

MENGGUNAKAN MS. WORD & EXCEL UNTUK GURU SMKN SEPATAN 

KABUPATEN TANGERANG. 
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